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PREFACE 

This manual is an application user's guide only, and does not give instruction on template writing 
techniques. 

There are several other documents complementary to this manual that cover topics associated 
with Tea and Tea-related tools.  These additional documents are available at 
http://opensource.go.com. 

For a list of the latest changes in Kettle, see Kettle's readme.txt file. 

 

http://opensource.go.com/
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1. AN INTRODUCTION TO KETTLE 

Kettle is an Integrated Development Environment (IDE) used to create and manage templates 
incorporating the Tea language (Tea templates).  Tea templates are most commonly used for 
creating dynamic web pages in the TeaServlet. 

1.1 Feature Summary 
• Includes an integrated Tea compiler 
• Performs syntax highlighting of Tea keywords 
• Allows Tea templates to be grouped into projects 
• Allows multiple Tea templates to be open at the same time 
• Reports compilation errors in a useful manner 

1.2 New in Kettle 4.0 
Although versions of Kettle prior to 4.0 are Java-based, they were designed to work only on the 
Windows platform.  Kettle 4.0 was rewritten to be 100% Java-compliant and to function on 
several platforms.  Additionally, Kettle 4.0 is easier to use and more powerful due to the 
following new features: 

• Additional find/replace functionality  
• Additional customizable preferences 
• Enhanced syntax highlighting 
• Improved function browser 
• Improved menus 
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2. INSTALLING AND STARTING KETTLE 

2.1 Requirements 
Kettle requires a Java2-complaint system, using Java 1.3 or newer.  On Win32 systems, Kettle 
requires 96mb of memory.  On Linux systems, Java 1.3.0 is recommended, due to the display 
bugs in Java 1.3.1.  These bugs are identified on the following web pages: 

http://developer.java.sun.com/developer/bugParade/bugs/4393527.html 

http://developer.java.sun.com/developer/bugParade/bugs/4487993.html 

2.2 Installation 
Installation of Kettle is simple.  Simply unzip Kettle into a folder of your choice.  You can 
download the latest version of Kettle from http://opensource.go.com/kettle.  Ensure that the Java 
Runtime Environment (JRE) is properly installed for the platform being used. 

2.3 Starting Kettle 
The Kettle distribution includes a batch file and shell script.  Windows users can start Kettle with 
kettle.bat.  Linux users can use the shell script kettle.sh.  Assuming java.exe is in the system 
path, Kettle can also be started from the command line with the following command: 

java -cp Kettle.jar com.go.kettle.Kettle 

http://developer.java.sun.com/developer/bugParade/bugs/4393527.html
http://developer.java.sun.com/developer/bugParade/bugs/4487993.html
http://opensource.go.com/kettle
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3. THE KETTLE INTERFACE 

3.1 Kettle Window Panes 
The Kettle interface is composed of three main windows, the navigation window, the output 
window, and the editor window.  Kettle uses a three-window work area to offer a variety of 
views and browsing options.  Above these windows are the menu bar and the toolbar.  Below the 
windows is a status bar. 

 
The Kettle GUI 

3.1.1 The Editor Window 
Kettle's editor window, the main window on the right side of the application, displays open 
templates as editable source code. 

The editor window is essentially the text editor where code is written and edited.  This is also 
where search and replace functions are performed on open files.  The text styles in this 
windowpane reflect the user's text highlighting preferences (see 4.2 Kettle Editor Preferences). 
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Kettle Editor Window 

3.1.2 The Navigation Window 
Kettle's navigation window contains the Project Explorer, Document List, or Function Browser.  
You can toggle between these modes by clicking on one of the three tabs near the bottom of the 
windowpane. 

  

  
Kettle Navigation Window � Project Explorer and Document List 
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Kettle Navigation Window � Function Browser and JavaBean Browser 

The Project Explorer (the default view) displays the project's name and a list of associated Tea 
templates.  The templates shown are those that exist in the directory containing the Kettle project 
file or a subdirectory.  Double-click a template in the list to open it in the editor window. 

The Document List displays a list of the currently open Tea templates.  Click on a template to 
display that template in the editor window. 

The Function Browser displays the list of built-in functions currently available for a project.  
Click on a function to view its details in the output window.  Click on the handle next to the 
Context Class title to expand or collapse its list of functions. 

The JavaBean Browser displays all JavaBeans available within your Project Classpath.  Click 
on a JavaBean to view its description.  Click on the handles next to the package titles to expand 
or collapse the lists of JavaBeans. 

3.1.3 The Output Window 
Kettle's output window contains the Type Browser, Compilation Errors, and any Search Results 
performed over multiple open documents or files.  You can toggle between these modes by 
clicking on one of the three tabs near the bottom of the windowpane. 
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Kettle Output Window � Type Browser 

 
Kettle Output Window � Compilation Error List 

 
Kettle Output Window � Search Results 
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The Type Browser (the default view) displays function descriptions or return type information.  
The Type Browser has forward and back buttons for navigating forwards and backwards through 
the content.  Next to these buttons is a history bar for browsing through previously requested 
type information. 

The Compilation Error List displays compilation errors.  This view is automatically displayed 
after any compilation. Templates can be compiled individually or all at once, so error listings 
include template names as well as error descriptions and line numbers where errors occur.  
Single-click an entry in the Compilation Error List to display the error in the editor window.  
Double-click an entry in the Compilation Error List to jump to that error and place the cursor 
focus in the editor window. 

The Search Results view displays a list of results from searches made using the Find in Open 
Documents and Find in Files tools.  The results are listed including the filename, file path, line 
number, and surrounding text.  To jump to the template where the search item was found, simply 
single-click on a result list entry.  Double-click on the entry to jump to the search item and place 
the cursor focus there.  If the list item corresponds to a file that is not open, the file is opened and 
the editor window displays the template.  (The Find Next and Find Previous tools simply jump 
to the single result in the editor window.) 

3.2 Kettle Menu Bar 
The Kettle menu bar, similar to other window-based applications, contains organized menus of 
Kettle commands.  Although commonly used commands can be activated from the toolbar, the 
menu bar is comprehensive. 

 

3.2.1 File Menu 
The file menu is used to open, close, save, or start templates and project files. 

Command Description 

New Creates a new Tea template. 

Open Opens an existing Tea template. 

Close Closes the current Tea template.  Kettle prompts the user regarding unsaved 
templates. 

Close All Closes all Tea templates.  Kettle prompts the user regarding unsaved templates. 

Save Saves the current Tea template. 

Save As Opens a dialog box that can save the current Tea template with a different filename or 
in a different location. 

Save All Saves all currently opened Tea templates. 

New Project Starts a new project. 
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Command Description 

Open Project Opens an existing project. 

Close Project Closes the current project.  Kettle prompts the user regarding an unsaved project. 

Save Project Saves the current project. 

(Recent 
Project List) 

Recently opened projects appear in the File Menu for easy access. 

Exit Exits Kettle, closing any open files first. 

Table 1 � Kettle File Menu 

3.2.2 Edit Menu 
The edit menu provides typical text-editing tools such as cut and paste.  See 6.2.1 Using Basic 
Editing Tools for detailed information. 

3.2.3 Search Menu 
The search menu provides typical tools for finding and replacing text, or jumping to specific 
locations in the template. 

Command Description 

(Find/Replace Tools) See 6.2.2 Using Find/Replace for detailed information. 

Go To� Jump to a specific line in a Tea template. 

Match Case Modifies the Find/Replace behavior to distinguish between uppercase and 
lowercase letters. 

Whole Word Modifies the Find/Replace behavior to distinguish between matching 
occurrences that are whole words only and not part of a larger word string. 

Match Bracket Jump to the opposite bracket "[ ]", brace "{ }", or parenthesis "( )".  This 
applies to Tea code regions only. 

Table 2 � Kettle Search Menu 

3.2.4 View Menu 
The view menu controls which toolbars are visible and which views are active in the navigation 
and output windows. 

Command Description 

Status Bar Toggles the status bar on and off. 

Toolbars Toggles the standard or search bars on and off. 

Project Explorer Makes the Project Explorer active in the navigation window. 

Document List Makes the Document List active in the navigation window. 
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Command Description 

Function Browser Makes the Function Browser active in the navigation window. 

JavaBean Browser Makes the JavaBean Browser active in the navigation window. 

Type Browser Makes the Type Browser active in the navigation window. 

Type Browser Navigation Navigates forward and backward through types in the Type Browser. 

Compilation Error List Makes the Compilation Error List active in the navigation window. 

Search Results Makes the Search Results active in the navigation window. 

Navigation Pane Toggles the navigation window on and off. 

Output Pane Toggles the output window on and off. 

Show Template in Browser Displays the template rendered in the selected browser. 

Refresh Reloads the classes and refreshes the views. 

Table 3 � Kettle View Menu 

3.2.5 Compile Menu 
The compile menu is used for compiling templates.  See 6.3 Compiling Templates. 

3.2.6 Configure Menu 
The configure menu is used to configure a Kettle project or to customize Kettle's environmental 
settings.  See 4 Setting Kettle. 

3.2.7 Window Menu 
The window menu is used to either close or navigate through the currently open templates. 

Command Description 

Next Window Jump to the next window. 

Previous Window Jump to the previous window. 

Close Close the current template. 

Close All Close all open templates. 

(Window List) Lists the currently opened templates for easy access. 

Windows� Opens a dialog box with a list of currently open templates for easy access. 

Table 4 � Kettle Window Menu 
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3.2.8 Help Menu 
The Help menu has links to websites with information covering topics such as Tea and Kettle.  
The location of your Internet browser must be correctly configured in Kettle (see 4.1 Kettle 
Environment Preferences). 

3.3 Kettle Toolbars 
Kettle has a standard toolbar and a search toolbar just below the menu bar.  To recover more 
space for Kettle's working windowpanes, either or both toolbars can be turned off in the View 
menu (see 3.2.4 View Menu).  All the functions on the toolbars are accessible in the menu bar. 

 

3.3.1 Standard Toolbar 
Tool Button Description 

New Template 
 

Starts a new template. 

Open Template 
 

Opens an existing template. 

Save Template 
 

Saves the current template. 

Save All 
 

Saves all open templates. 

New Project 
 

Starts a new project. 

Open Project 
 

Opens an existing project. 

Cut 
 

Cuts selected item into the clipboard. 

Copy 
 

Copies selected item into the clipboard. 

Paste 
 

Pastes clipboard content. 

Undo 
 

Undo the last action. 

Redo 
 

Redo the previous "Undone" action. 

Display Type Info 
 

Displays a description of the current variable or function type in the 
Type Browser. 

Show/Hide 
Navigation Pane  

Toggles the navigation pane on and off.  Hiding the navigation pane can 
recover space for other windows. 

Show/Hide 
Output Pane  

Toggles the output pane on and off.  Hiding the output pane can recover 
space for other windows. 
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Tool Button Description 

Show Template in 
Browser  

Renders the current template in the selected browser.  This gives authors 
a preview without having to compile and reload templates. 

Compile Template 
 

Compiles the current template. 

Compile All 
 

Compiles all templates in the current project. 

Reload TeaServlet 
Templates  

Instructs the TeaServlet to reload its templates. 

Table 5 � Standard Toolbar 

3.3.2 Search Bar 
The buttons in the search bar are explained in detail in 6.2.2 Using Find/Replace. 

3.4 Status Bar 
Kettle has a status bar at the bottom of the application used to display miscellaneous data such as 
the current cursor location and the results of a find/replace action.  The status bar also displays 
brief yet helpful information when the mouse pointer is hovering over one of Kettle's buttons. 

 
The status bar can be turned off in the View menu in order to recover more space for the other 
windows in Kettle (see 3.2.4 View Menu). 
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4. SETTING KETTLE PREFERENCES 

Kettle supports many custom environmental settings that users can change to more closely match 
their preferences.  To edit these settings, select Preferences from the Configure menu.  The 
following dialog box opens: 

 
Table 6 and Table 7 in the following sections describe the preference settings and their 
meanings. 

4.1 Kettle Environment Preferences 
Type Setting Meaning 

Reload Last Project on Startup When started, Kettle automatically opens the last project 
it handled. 

General 

Most Recently Used Files When users open the file menu, this setting determines the 
number of recently used files that are listed for easy 
access. 

Prompt for name when creating 
new template 

When creating a new template, Kettle prompts you for the 
template name.  The name is inserted into the template 
and is the default name for saving.  If this option is 
disabled, Kettle uses generic template names. 

Open associated project when 
opening template 

When a template is loaded and no projects are open, 
Kettle automatically opens the project associated with 
that template. 

Restore workplace state when 
opening project 

When a project is opened, Kettle automatically restores 
the project's workplace state.  All previously open 
templates are opened and the navigation window is 
restored with its previous content. 

File 

Saves files on successful 
compile all 

When Kettle successfully compiles all of the templates 
due to a "compile all" action, the templates are also all 
saved. 
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Type Setting Meaning 

 Save project file on OK of 
Project Properties dialog 

The project file automatically saves when a user makes 
changes to the project properties. 

Kettle view preference "Split vertically" provides the navigation window with 
more space.  "Split horizontally" provides the output 
window with more space. 

View 

Show Path Names in the 
Document List 

Templates listed in the Document List show their path 
information relative to the project file. 

HTML 
Browser 

Path to HTML browser location Identifies the path to your preferred HTML browser.  
Either type in the path and filename or identify the 
browser executable by using the Browse button.  This is 
only used for the help commands in the help menu. 

Table 6 � Kettle Environment Preferences 

4.2 Kettle Editor Preferences 
Type Setting Meaning 

Enable automatic 
indentation 

The text editor automatically provides indentation within a 
template, following the current tab behavior.  (See tabs 
below.) 

Show property list when "." 
is typed 

A list of available property types is displayed when 
property statements are being typed. 

Underline compilation 
errors 

Compilation errors are underlined in the text editor. 

Automatically underline 
errors as you type 

Syntax and type errors are underlined automatically as you 
type in the text editor. 

Show contextual error 
message tooltips 

When hovering the mouse pointer over text with an error, a 
tooltip displays that error. 

Show contextual type info 
tooltips 

When hovering the mouse pointer over a variable, a tooltip 
displays that variable's type. 

Automatically highlight 
matching brackets 

When the cursor is present over one bracket, the matching 
bracket is also highlighted. 

General 

Block cursor This switch toggles between a vertical bar cursor and a 
block cursor. 

Keep tabs Using the tab key in the text editor inserts a tabbed space. 

Insert spaces Using the tab key in the text editor inserts spaces.  The 
number of spaces is defined in the "Spaces per tab" setting. 

Tabs 

Spaces per tab When the "Insert spaces" setting is used, "Spaces per tab" 
identifies how many spaces are inserted when the tab key is 
pressed. 

Font Font This defines the font name and size for the text editor.  A 
ll l f h l d fi d f i di l d



  Kettle 4.x User Manual 

  Page 18 

Type Setting Meaning 
small sample of the currently defined font is displayed. 

Item Syntax highlighting allows you to customize text 
appearance by emboldening, italicizing, or adjusting the 
foreground and background colors. 

Different types of text, such as Tea code, HTML, or 
reserved words, are identified by Kettle and highlighted 
differently, according to your settings. 

To adjust the settings for an item, select it from the item 
list and adjust the Foreground, Background, Bold, and 
Italic settings. 

Syntax 
Highlighting 

Enable syntax highlighting This switch toggles syntax highlighting on and off.  
Turning off syntax highlighting may improve Kettle's 
performance when handling very large templates. 

Table 7 � Kettle Editor Preferences 
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5. USING A KETTLE PROJECT FILE 

One of Kettle's strengths is the Kettle project file (.kpj).  Project files are used by Kettle to group 
Tea templates in one logical collection.  Project files also associate the templates with the files 
they rely upon, such as specific classpaths and context classes.  This allows Kettle to compile all 
the templates in a project at once (see 6.3 Compiling Templates). 

Several of Kettle's features, such as the project explorer, document list, and function browser, 
rely upon the properties for the project classpath and the context classes. 

To create a project file, select New Project from the File menu. 

When you create a project in Kettle, the project properties should match the environment that the 
templates are used with.  For example, the context classes configured in the Kettle project file 
should be the same context classes used by the TeaServlet.  This ensures that any templates 
written for the project have access to the same functions that the TeaServlet does.  Given 
identical context classes, a successful compile in Kettle helps to ensure a successful template in 
the TeaServlet. 

In many cases, the default configured context class is adequate for a simple Tea template.  
However, if your Tea templates are using functions contained in custom context classes, then 
these context classes need to be configured in the Kettle project. 

5.1 Configuring the Project File (with TeaServlet) 
If you are not using TeaServlet or you wish to manually customize your project's properties, see 
5.2 Configuring the Project File Manually. 

Kettle can integrate with TeaServlet to help automate the setting and maintenance of your 
project's properties.  With this option, Kettle automatically uses the same classpaths and context 
classes as the TeaServlet you direct it to.  (TeaServlet integration requires TeaServlet 1.3.1 or 
newer.) 

To configure TeaServlet integration, you need to configure the Project Properties to take their 
settings from the TeaServlet admin page.  Select Project Properties from the Configure menu.  
Click on the TeaServlet tab, enable Link Project to TeaServlet, and enter the URL to the 
TeaServlet admin page.  If the URL is correct, the Classpath and Context Classes tabs should 
contain read-only settings.  For further instructions about accessing and understanding the 
TeaServlet administration pages, see the TeaServlet User Manual, available for download at: 
http://opensource.go.com/teaservlet. 

If an Incompatible TeaServlet error message appears, double-check the URL in your browser 
and ensure that the TeaServlet version is 1.3.1 or newer.  The TeaServlet version appears in the 
upper right-hand corner of the TeaServlet admin pages. 

TeaServlet integration causes two additional tools to appear on the toolbar and in the menus.  
The following table describes these tools: 

http://opensource.go.com/teaservlet
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Tool Button Description 

Show Template in 
Browser  

This launches your configured browser and displays the HTML portion 
of the template. 

Reload TeaServlet 
Templates  

This causes the TeaServlet to recompile and reload any changed 
templates.  This tool is identical to using the reload button on the 
TeaServlet's template administration page. 

Table 8 � TeaServlet Tools 

5.2 Configuring the Project File Manually 

5.2.1 Configuring Classpaths 
The project's classpaths are directories, JAR files, or ZIP files containing Java class files 
(JavaBeans) that are used by the project's templates.  The classpath tells Kettle where to find 
the context classes and the classes that the context classes depend on.  You need to 
configure classpaths before context classes, or an error may occur. 

To add, edit, or delete entries in a project classpath, select Project Properties from the 
Configure menu, and then make your modifications in the Classpath tab of the Project 
Properties dialog.  Use the New button to add a Classpath entry.  Use the Edit button to modify 
the selected Classpath entry.  Use the Delete button to delete all selected Classpath entries.  The 
order of the classpaths configured here should match the order used in your Tea environment. 

If a class is located in more than one classpath, Kettle uses the class from the first classpath it 
finds the class.  You can change the order of the classpath entries by selecting an entry or 
multiple entries and clicking on the up and down buttons. 

 

Kettle Project Properties - Classpath 
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5.2.2 Configuring Context Classes 
A project's Context Classes define the functions available to its templates. Although Kettle ships 
with a default Runtime Context Class, other developers can construct enhanced versions.  The 
default Context Class is com.go.tea.runtime.UtilityContext.  This is included by default during 
installation of Kettle. 

To add, edit, or delete Runtime Context Classes for this project, select Properties from the 
Project menu, and then make your modifications in the Context Classes tab of the Project 
Properties dialog.  Use the New button to add a Context Class entry.  Use the Edit button to 
modify the selected Context Class entry.  Use the Delete button to delete all selected Context 
Class entries.  Any Context Classes you add must be located in the project's Classpath or an error 
occurs.  You must have at least one Context Class or an error occurs. 

You can change the order of the entries in the project's Context Classes by selecting an entry or 
multiple entries and clicking on the up and down buttons.  Changing the order of the Context 
Classes in the properties also changes the order that they display in the navigation window.  The 
order does not affect the way Kettle compiles. 

 

Kettle Project Properties � Context Classes 

If the context classes are configured correctly, the Project Explorer should display the templates 
and subfolders based on the location of the Kettle project file (there may be nothing to display).  
Also, the Function Browser should display the list of available context classes and their 
functions. 
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5.2.3 Configuring the Template Path 
The project's template path contains a list of template folders.  For easy access, the Project 
Explorer displays these paths and templates, as illustrated in the following figure: 

 
Kettle Project Explorer � Template Path 

To add, edit, or delete template folders for this project's template path, select Properties from 
the Project menu, and then make your modifications in the Template Path tab of the Project 
Properties dialog.  Use the New button to add a folder.  Use the Edit button to modify the 
currently selected folder.  Use the Delete button to delete all selected folder entries. 

 
Kettle Project Properties � Template Path 
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6. WORKING IN KETTLE 

6.1 Creating a Template 
To create a new template, select New from the File menu.  Kettle displays a basic template in the 
editor window and list the template in the Document List. 

The template does not appear in the Project Explorer until the template is saved.  To save the 
template, select Save from the File menu.  The filename must match the template name or a 
compile error occurs.  (The template name is located in the template itself, directly after the 
keyword "template".)  Also ensure that the template is saved in the correct folder with your 
project file. 

6.2 Editing Templates 
Kettle provides standard text editing functionality for writing and editing Tea templates, plus a 
number of optional features such as keyword highlighting, statement completion, and error 
underlining. 

6.2.1 Using Basic Editing Tools 
Standard Windows-style text editing tools are accessed from the Edit menu. 

 

Cut, Copy, Paste, Undo, Redo, and Display Type Info are also available from the toolbar.  

 
Kettle supports multiple levels of undo and redo.  However, any template change following an 
undo clears the redo buffer. 

Display Type Info displays (in the output window) the syntax for the variable or function at the 
cursor position. 
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6.2.2 Using Find/Replace 
Kettle features a powerful suite of find/replace tools, all easily accessible in a toolbar.  This 
toolbar is composed of a Find textbox, Find buttons, Replace textbox, Replace buttons, and two 
filter buttons. 

 
To find text, type that text into the Find box and click on the appropriate Find button.  The 
following table describes the Find tools. 

Tool Button Description 

Find Next 
 

Finds the next instance of the search text.  This searches the currently 
active document forwards from the cursor. 

Find Previous 
 

Finds the next instance of the search text.  This searches the currently 
active document backwards from the cursor. 

Find in Open 
Documents  

Finds all instances of the search text in all currently open documents.  
The search results display in the output window. 

Find in Files 
 

Finds all instances of the search text in all files of a selected folder.  The 
search results display in the output window. 

Table 9 � "Find Text" Tools 

To replace text, type the old text into the Find textbox and the new text into the Replace textbox.  
Click on the appropriate Replace button.  The following table describes the Replace tools. 

Tool Button Description 

Replace Next 
 

Finds the next instance of the search text and replaces it with the 
replacement text.  This searches the currently active document forwards 
from the cursor. 

Replace All 
 

Finds all instances of the search text and replaces them with the 
replacement text. 

Replace in Open 
Documents  

Finds all instances of the search text in all currently open documents and 
replaces them with the replacement text. 

Table 10 � "Replace Text" Tools 

Both find and replace functions can be limited to only those instances where the text matches the 
case or the whole word.  Clicking on the Match Case or Whole Word buttons can toggle these 
filters.  These filters are described in the following table. 

Filter Button Description 

Match Case 
 

The find or replace action distinguishes between uppercase and lowercase 
letters.  Only those instances that match cases are found or replaced. 

Whole Word 
 

The find or replace action only searches or replaces whole words and not 
instances where the search text matches part of a larger word. 

Table 11 � Find/Replace Filters 
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6.2.3 Syntax Highlighting 
Kettle's text editor supports multiple fonts and colors for text used within the editor.  This 
customizable feature allows users to distinguish between code and text regions as well as provide 
an easier way to read templates. 

To customize or disable syntax highlighting, select Preferences from the Configure menu, 
select Syntax Highlighting, and adjust the settings accordingly.  (See Table 7 � Kettle Editor 
Preferences.) 

6.2.4 Statement Completion 
A list of available property types is automatically displayed when property statements are being 
typed. The properties list selects the closest match, updating continuously as you type. Press 
Enter, Tab, or Spacebar at any time to insert the selected property name. 

 
To enable or disable the Auto list properties option, select Preferences from the Configure 
menu, select General, and toggle the setting for Show property list, when "." is typed. 

6.2.5 Error Underlining 
Syntax and type errors are automatically underlined by Kettle.  Compile errors are underlined by 
Kettle after an unsuccessful compile. 

 
To enable or disable error underlining, select Preferences from the Configure menu, select 
General, and toggle the setting for Automatically underline errors as you type.  To enable or 
disable error underlining only for compile errors, toggle the setting for Underline compilation 
errors in the same dialog box. 

6.3 Compiling Templates 
To compile the Tea template currently in the editor window, select Compile Template from the 
Compile menu.  To compile all templates in the project, select Compile All from the Compile 
menu. 

When the templates have finished compiling, the Compilation Error List opens or updates at the 
bottom of the application, and any compilation errors are underlined in the template (if 
Compilation Error Underlining is enabled). 
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By default, Kettle automatically saves changes when a "Compile All" is successful. To disable 
this option, select Preferences from the Configure menu, click on File, and uncheck the setting 
named Automatically save files on successful compile all. 

If you would like to preview a template without compiling it first, click on Show Template in 
Browser from the View menu. 
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